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“When pumps stop, so does everything” 
 

Johnson Pump SPX Process Equipment NL B.V., part of SPX Flow Technology segment, 
designs, manufactures and markets Johnson Pump Brand pumps.  
The tradition in the pump industry goes back to the 19th century and 
combines a high level of technological know-how with long lasting quality 
pumps. SPX Process Equipment NL B.V. is one of a few pump producers in 
the Netherlands for centrifugal pumps. We have an outstanding Research & 
Development department and a test bed to perform all the tests required.  
The design standards for our centrifugal pumps are EN (DIN), ISO and API. 
The rule for assembly is: one person one pump. In our assembly cells, highly 
skilled employees have everything needed within reach. Within a short time, 
they can assemble most common required variations exactly according to 
customer specifications. 
Last but not least we have an extended After Sales & Service department 
which completes our philosophy; a solution provider in the transport of low 
viscosity liquids.  
In the Netherlands we focus mainly on horticulture, shipbuilding and 
(chemical) industry. Besides the Netherlands we are represented in several 
European countries and the USA by SPX sales offices, as well as through 
distributors and agents world-wide. Production facilities are in the 
Netherlands, Belgium, Sweden, the U.S.A. and India.  
For more information about Johnson Pump products please visit 
www.johnson-pump.com 
 

SPX SPX is a Fortune 500, global multi-industry manufacturing leader. SPX 
divides its business into four segments and one of these is the SPX Flow 
Technology segment. SPX Flow Technology designs, manufactures and 
markets engineered solutions & products used to process, blend, meter and 
transport fluids. We also have products for heat transfer applications, and 
products for air & gas filtration and dehydration. We are recognized globally 
for our leading brands and products, and our systems capability – particularly 
in the Food & Beverage, Power & Energy and Industrial markets. Visit our 
website at www.spxft.com to learn more about the brands in the SPX Flow 
Technology portfolio. 
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Main menu  HYDRAULIC INVESTIGATOR 
 
 
Starting up The program is started by clicking the HI2 icon on your desktop or from the 

program menu. 
 
 
 
 

 
The main menu gives various options for using the database. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Q-H selection: by entering a Q-H value (and supplementary criteria) the 
whole database is automatically searched for suitable pumps. 

2. Pump selection: a pump family and pump type can be entered directly. 
The graph is then displayed on the screen. 

3. Retrieve: a previously saved pump curve can be viewed once again. 
4. Exit: after making a selection, saving and if necessary printing this out, 

the program can be closed. 

 
Version information First of all, you have to check the HI2 version you are working with. 

Select the Help pull-down menu, and then the about option.  
On top of the new window, the current version will appear. 
Version 10.18C stands for:  
Program revision  : 10 
Database revision  : 18 
Program source  : C = Citrix server  

       H = Horticulture version 
       X = beta release 
          = stand alone Full version 
 

The current version is also shown at the bottom of every print, made in HI2.
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Q-H selection 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Minimum information The minimum information required is a Q-value and H-value. If these are not 

entered an error message appears.  

 
Capacity / Head  For the Capacity, the units can be selected. If m3/h is chosen here, then all 

capacities are entered in m3/h and all pressures in metres. If USGPM is 
chosen, the capacity must be entered in USGPM and the pressure in feet.  

 
Viscosity The viscosity can be entered in mm2/sec (=cSt) or in mPa.s (=cP). When 

entered in mPa.s, it is very important to fill in the Information about the 
specific gravity correctly, as this is part of the viscosity correction calculation. 

 
Density The density affects viscosity and power. Default value is 1000 kg/m3, as for 

water. 
 

NPSHa If the available NPSH is known, this value can also be included in the 
selection. Here, a safety margin of 0.5 metres must be kept (for trimmed 
impellers or at the end of the curve: 1 m.). 

 
Oper. Region The operating region has a standard value of 20% - 120% of BEP. All pumps 

shown in the selection that are outside this region, will be coloured red. This 
region can be changed into API 610, corresponding to 80% - 110% of BEP. 
Also a user defined region is available. 

 
Pre-selection  A pre-selection of pump family, impeller type and impeller material type can 

be made. This is done by clicking at the boxes with 3 points which are after 
these fields.  
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Several items can be selected simultaneously in these selection windows. 
Some choices under pump family represent several pump families together.  
When Combi has been chosen as pump family, a selection of Combi Sub-
types can be made. 

 
Sub-classification of The table below gives an overview of the sub-classification of pump families. 
pump families  

Pump family Subtype Embedded Pump families 
BUS  BUS 

BULS 
RBU 

Combi CombiBloc 
CombiChem 
CombiFlex 
CombiMag 
CombiMagBloc 
CombiNorm 
CombiPact 
CombiPrime H 
CombiPrime V 
CombiSump 
CombiWell 

CombiBloc 
CombiChem 
CombiFlex 
CombiMag 
CombiMagBloc 
CombiNorm 
CombiPact 
CombiPrime H 
CombiPrime V 
CombiSump 
CombiWell 

CombiBlocHorti  CombiBlocHorti 
CombiDirt  CombiDirt 
CombiLine  CombiLine 
CombiLine B  CombiLine B 
CombiPro  CombiPro 
FRE  FRE 

FRES 
FREF 
FREM 

HCR  HCR 
PHA 

KGE  KGE 
KGEF 
KGEL 

MCH  MCH 
MCHW 
MCHS 

MCHZ  MCHZ 
MCHZS 

MCV  MCV 
MCVS 

MDR  MDR 
MSH  MSH 

MSHS 
MSO/MSF  MSO 

MSF 
NURT  NURT 
VRD  VRD 

VRD O 
VRDA 
VRDA O 

(R) NUK  NUK 
RNUK 
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Impeller diameter For pumps having variable impeller diameter, the impeller diameter is 

calculated in such a way that the curve goes straight through the entered 
duty point. Pumps with fixed impeller diameter always have a curve with a 
deviation from the entered duty point.  

 
Multistage With multistage pumps the maximum speed depends on the number of 
centrifugal pumps stages. To prevent selection of pumps beyond maximum speed, the 

multistage  pumps have been divided into a number of sub-groups, like in 
the TSM on page “operational range”. 

 
Maximum permitted  Curves of pumps with fixed impeller diameter never go straight through the 
deviation  duty point. 

The maximum permitted deviation is entered under Tolerance. This is set at 
5% by default. 

 
Adjustment of  CombiSump pumps have an increased absorbed power consumption 
absorbed power because of the use of intermediate bearings. The number of bearings can be 

put in the field CS Bearings. The power will be adjusted according to the 
number of bearings. 
Also the self-priming part of the CombiPrime H and CombiPrime V and 
MCHZ pumps causes an increase of absorbed power. This will be calculated 
automatically. 
 

Net frequency and speed Under Frequency, the net frequency can be entered: 50Hz or 60Hz. When 
making a selection, the correct speeds are then automatically used. A pecific 
speed can also be entered in the Speed field. 
 

Required efficiency  Under Efficiency, the required minimum efficiency can be entered (if 
known). This concerns the hydraulic efficiency associated with the graph. 

 
Activating the selection  After all the required settings have been made the selection is activated 

using the Search button in the Q-H selection window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A list is shown of all graphs that meet the specified requirements. Pumps 
outside the chosen operating region are shown in red. If desired, pumps can 
be removed from the selection list by double-clicking on the relevant pump. 
By doing this, the selection arrow at the front of the line is removed. 
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Sorting  By default the pumps are sorted by their efficiency. However using the Sort 
menu various other sorting keys are possible. 

 
 
 
 
 
 
 
 
Displaying the graph  The graph is displayed by selecting the relevant type and then clicking the 

Graph button. 
 

Interpretation of the selection results 
 

Pay attention to following point: 
 Selected curves concern a selection of hydraulics, not pumps. This 

means that the selected graph must always be checked for its availability 
in the product supply range. Especially the speed / bearing-type  
combination must be checked using the TSM.
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Available pump families The second way of selecting a graph is through the option: Pump Selection. 

Using this, a list of all pump families available in HI2 is displayed.  
 
Select pump type  After choosing a pump family, a pump type can be selected. When holding 

down the Ctrl key while pressing the left mouse button, several types can be 
selected at the same time. 

 

Pump curves 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Requesting graphs A graph can be requested from both the Q-H selection and the Pump 

selection. In both cases the screen displayed above becomes visible. This 
screen is split into a left and right window. The left window shows the graph, 
the right window the associated data. 
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Graph window The graph window is divided into 3 parts.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Top The upper part shows the capacity - power curve. 
 
Middle The middle part shows the following information: 

1. the selected capacity – head curve.  
2. the efficiency curve (2nd Y-axis at right side of the graph) 
3. the capacity – system resistance curve (system curve) based on 

the specified working point.  
The static head can be set using the menu-item Options… Static 
head. 

4. The specified duty point. 
 
Bottom The lower part shows the capacity - NPSH curve. 

 
Display menu Using the options in the Display menu, the aforementioned curves for all 

graphs can be switched on and off as desired. 
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Parallel arranged It is possible to set a graph for 2, 3 or 4 pumps arranged in parallel. The 
option Parallel pumps in the Options menu must be used to do this. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Data window The data window consists of 4 columns. Each one describes an individual 

situation. 
Each column can be switched on and off by ticking the box at the top of the 
relevant column.  
The grey fields in the column indicate values which cannot be altered. The 
light fields can be changed by the user. After filling in a field, the field must 
be left in order to activate the change. This can be done using the Tab-key 
or by clicking another field. 
 

Impeller diameter The impeller diameter can be varied between the minimum and maximum 
value for the relevant pump type. 

 
Viscosity When known, the viscosity of the medium to be pumped can be entered 

here. 
 
Density The density of the medium. 
 
Speed The motor speed can be varied up to the maximum speed for the type of 

pump. 
 
Orifice The effect of an orifice can be seen by ticking this option. The Pressure drop 

at the working point or the diameter (of the hole in the orifice) can then be 
entered. 
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Navigation keys  In order to view another graph from the selection, use can be made of the 

navigation keys at the bottom of the data screen  
 or the selection menu. 

 
Comparing 2 graphs It is also possible to compare two curves with each other. In order to do this, 

the option 2 Graphs must be chosen from the Display menu (or using the 
function key F2). Using the navigation keys or the selection menu, all the 
curves in the selection can now be looked at one by one. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Magnet Correction When a CombiMag or CombiMagBloc has been selected, an extra field 

appears in the Data Window: Magnet corr.. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
The value of the magnet correction has to be copied from the CombiMag 
calculation program and indicates the power absorption of the magnet 
coupling. 
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Saving graphs The completely modified graph can be saved so that this can again be easily 

retrieved at a later moment in time (see RETRIEVE). The graph is saved by 
using the File menu and then choosing Save as… 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Compulsory entry fields In the next dialogue box, a number of details can be assigned to the graph. 
dialogue box  Compulsory entry fields are: Quotation, Item, Customer nr, Date and 

Customer name. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Alternate saving method An other way to store your graphs is the use of a PDF printer driver, like 

cutePDF. All you have to do is to start a print Job with the PDF printer as 
selected printer. 
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Retrieve 
 

Retrieving graphs Using the Retrieve option, all processed and saved graphs can be retrieved. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A selection can be made in the window shown above from the various saved 
quotations.   

 
Searching and sorting Using the Sort menu, a sorting sequence can be selected and using the 

Search option a specific quotation can be quickly found. 
The relevant item is selected in the lower window and the graph for this is 
then displayed. 
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